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 Рассмотрено на заседании предметно-цикловой комиссии 

общепрофессиональных, специальных дисциплин и дипломного 

проектирования по специальностям 08.02.01. Строительство и эксплуатация 

зданий и сооружений, 08.02.07. Монтаж и эксплуатация внутренних 

сантехнических устройств, кондиционирования воздуха и вентиляции, 

43.02.08. Сервис домашнего и коммунального хозяйства. 

   

 

Данные методические указания предназначены для студентов 

специальности 09.02.04. Информационные системы (по отраслям) БПОУ ВО 

«Вологодский строительный колледж» при выполнении практических работ 

по МДК.03.01. Технология работы с аппаратным обеспечением и 

операционной системой персонального компьютера, периферийными 

устройствами. 

Объем практических работ по МДК 03.01. Технология работы с 

аппаратным обеспечением и операционной системой персонального 

компьютера, периферийными устройствами составляет 20 часов. 

 

 

Автор: Норинова С.В., преподаватель БПОУ ВО «Вологодский строительный 

колледж» 
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ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 

МДК.03.01. Технология работы с аппаратным обеспечением и операционной 

системой персонального компьютера, периферийными устройствами ПМ.03. Выполнение 

работ по одной или нескольким профессиям рабочих, должностям служащих (оператор 

электронно-вычислительных и вычислительных машин) является вариативной частью 

учебных циклов в соответствии с ФГОС и преподается студентам специальности 09.02.04. 

Информационные системы (по отраслям). 

В результате освоения ПМ.03. обучающийся должен иметь практический опыт: 

 инсталляции, настройки и сопровождения одной из информационных систем; 

 выполнения регламентов по обновлению, техническому сопровождению и 

восстановлению данных информационной системы; 

 сохранения и восстановления базы данных информационной системы; 

 организации доступа пользователей к информационной системе в рамках 

компетенции конкретного пользователя; 

 обеспечения сбора данных для анализа использования и функционирования 

информационной системы и участия в разработке проектной и отчетной 

документации; 

 определения состава оборудования и программных средств разработки 

информационной системы; 

 использования инструментальных средств программирования информационной 

системы; 

 участия в экспериментальном тестировании информационной системы на этапе 

опытной эксплуатации и нахождения ошибок кодирования в разрабатываемых 

модулях информационной системы; 

 разработки фрагментов документации по эксплуатации информационной системы; 

 участия в оценке качества и экономической эффективности информационной 

системы; 

 модификации отдельных модулей информационной системы; 

 взаимодействия со специалистами смежного профиля при разработке методов, 

средств и технологий применения объектов профессиональной деятельности; 

уметь: 

 осуществлять сопровождение информационной системы, настройку под конкретного 

пользователя, согласно технической документации; 

 поддерживать документацию в актуальном состоянии; 

 принимать решение о расширении функциональности информационной системы, о 

прекращении эксплуатации информационной системы или ее реинжиниринге; 

 идентифицировать технические проблемы, возникающие в процессе эксплуатации 

системы; 

 производить документирование на этапе сопровождения; 

 осуществлять сохранение и восстановление базы данных информационной системы; 

 составлять планы резервного копирования, определять интервал резервного 

копирования; 

 организовывать разноуровневый доступ пользователей информационной системы в 

рамках своей компетенции; 

 манипулировать данными с использованием языка запросов баз данных, определять 

ограничения целостности данных; 

 выделять жизненные циклы проектирования компьютерных систем; 

 использовать методы и критерии оценивания предметной области и методы 

определения стратегии развития бизнес-процессов организации; 

 строить архитектурную схему организации; 

 проводить анализ предметной области; 
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 осуществлять выбор модели построения информационной системы и программных 

средств; 

 оформлять программную и техническую документацию, с использованием 

стандартов оформления программной документации; 

 применять требования нормативных документов к основным видам продукции 

(услуг) и процессов; 

 применять документацию систем качества; 

 применять основные правила и документы системы сертификации Российской 

Федерации; 

знать: 

 основные задачи сопровождения информационной системы; 

 регламенты по обновлению и техническому сопровождению обслуживаемой 

информационной системы; 

 типы тестирования; 

 характеристики и атрибуты качества; 

 методы обеспечения и контроля качества; 

 терминологию и методы резервного копирования; 

 отказы системы; 

 восстановление информации в информационной системе; 

 принципы организации разноуровневого доступа в информационных системах, 

политику безопасности в современных информационных системах; 

 цели автоматизации организации; 

 задачи и функции информационных систем; 

 типы организационных структур; 

 реинжиниринг бизнес-процессов; 

 основные модели построения информационных систем, их структуру, особенности и 

области применения; 

 особенности программных средств используемых в разработке информационных 

систем; 

 методы и средства проектирования информационных систем; 

 основные понятия системного анализа; 

 национальную и международную систему стандартизации и сертификации и систему 

обеспечения качества продукции, методы контроля качества 

В соответствии с учебным планом на изучение МДК.03.01 Технология работы с 

аппаратным обеспечением и операционной системой персонального компьютера, 

периферийными устройствами отводится 135 часов, в том числе 20 часов – практические 

занятия. 

Целью практических занятий является формирование практических умений, 

необходимых в последующей учебной и профессиональной деятельности.   

Содержание практических занятий по МДК МДК.03.01 Технология работы с 

аппаратным обеспечением и операционной системой персонального компьютера, 

периферийными устройствами направлено на реализацию требований Федерального 

государственного образовательного стандарта по специальности СПО 09.02.04. 

Информационные системы (по отраслям). Практические занятия включает следующие 

структурные элементы:  

1) инструктаж, проводимый преподавателем,  

2) самостоятельная деятельность обучающихся,  

3) анализ и оценка выполненных работ. 

Контроль и оценка результатов выполнения обучающимися работ, заданий на 

практических занятиях направлены на проверку освоения умений, практического опыта, 
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развития общих и формирование профессиональных компетенций, определённых 

программой учебной дисциплины.  

Оценки за выполнение заданий на практических занятиях выставляются по 

пятибалльной системе и учитываются как показатели текущей успеваемости 

обучающихся. 
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ПЕРЕЧЕНЬ ПРАКТИЧЕСКИХ ЗАНЯТИЙ 

МДК .03.01 Технология работы с аппаратным обеспечением и операционной системой 

персонального компьютера, периферийными устройствами 

№ 

п/п 

Тема  

программы 

Тема  

работы 

Количество 

часов 

1.  Тема 2.  

Технология работы с 

операционной системой 

персонального 

компьютера 

Установка операционной системы.  2 

2.  Установка драйверов. 2 

3.  Построение одноранговой сети. Настройка 

локальной сети. 2 

4.  Тема 3.  

Технология работы с 

периферийными 

устройствами 

Комплектация рабочих мест средствами 

вычислительной техники. 
2 

5.  Устройства для работы с информацией на 

твердых носителях. 
2 

6.  Разбиение жесткого диска на разделы 

различными средствами. Работа с программным 

обеспечением по обслуживанию жёстких 

магнитных дисков. 

2 

7.  Подключение и инсталляция принтера. 

Настройка параметров работы принтеров. 

Замена картриджей. 

2 

8.  Настройка параметров устройств обработки 

звука. 
2 

9.  Подключение и инсталляция сканера. 

Настройка параметров работы сканера. 

Сканирование документов. 

2 

10.  Настройки и способы сетевых подключений 

офисной техники. Работа с офисной техникой. 
2 
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ПОРЯДОК ВЫПОЛНЕНИЯ ПРАКТИЧЕСКИХ РАБОТ 

Практическая работа №1  

Установка операционной системы.  

Цель работы: сформировать умения установки Windows XP 

Задание 1. Изучение процесса установки Windows XP 

Методические указания по выполнению задания: 

Windows XP – это одна из самых популярных операционных систем с удобным 

пользовательским интерфейсом. Она инсталлируется как на новые персональные 

компьютеры, купленные в магазине, так и на ПК, собранные собственными руками. Как 

правило, в случае магазинной сборки, операционные системы устанавливают сборщики и 

тестировщики. По умолчанию, это – Windows. Сегодня это, конечно же, Windows XP, 

поскольку такие версии этой ОС, как Windows 98, Windows 2000 уже давно устарели и 

практически не используются на новых машинах, архитектура которых за последние 

несколько лет менялась не раз. Так как прогресс не стоит на месте, и современные ПК 

собирают с использованием новейших продуктов, соответственно и операционная система 

должна соответствовать современным требованиям для наилучшей работы вашего 

компьютера.  

Как же установить Windows XP на только что собранный вами компьютер!? 

Прежде всего, следует приобрести установочный компакт-диск с данной операционной 

системой. МирСоветов не рекомендует вам покупать нелицензионную продукцию, 

несмотря на то, что она может оказаться несколько дешевле лицензионной. Во-первых, с 

лицензионным продуктом вы будете уверенны в его качестве, а во-вторых, не возникнет 

никаких проблем с регистрацией вашей ОС. Бывает и так, что пиратские установочные 

диски поставляются без так называемого «ключа», без которого вы не сможете успешно 

загрузить ОС на свой компьютер. В комплектации с лицензионным диском такой ключ 

есть.  

Установка Windows XP. Шаг первый. 

Итак, мы имеем: новый компьютер и CD с Windows XP. Включите компьютер и вставьте 

инсталляционный диск с ОС в CD- или DVD-ROM. В случае необходимости, 

перезагрузите компьютер и зайдите в BIOS (setup), нажав кнопку “DEL”, для изменения 

опций загрузки вашего ПК (нас интересует параметр «загрузка с компакт-диска»).  

 
 

Так выглядит меню BIOS. 

Для изменения параметров выбираем вкладку Advanced – Advanced BIOS Features. 

http://click02.begun.ru/click.jsp?url=tQTDjnB4eXjvCZDvJwWzt6XFnealRuUYKjqunVy6j18ipVtXEL9q5kjNRizTvWwZI16eFjriqNHw-PqgL1CCFa2tSjd0DUJ13Zags4NucDUWaWfz4c*1eKebLpjeKBo*y9U-q3Urea3L*9-x92r-5Nk5g9AA2yq4ClGupp5ZuGzkPc19xqGc*D6KOckJZT7PLeFA*dW2JIwTWr-x2d76zBDVHlgDCcnzy-TPIxIzHtJTAJ*2hYZ2BWsNzlhZIjk4Oh5fLzf9vS8oJp2Lrq6ovcnFXNqdfzw0u7p1eaD5OSAbj-PRfLx9noOu4Bq975POTG6IMVKlxGx4Gk5SljXolSTYtiN5HDURu9H-TAEoQtENvTZFmknDdeSftYzUtxNb74yUykYGDj8cILzF2eVaMvJ9H6ENDu8Td*-y9rZqrpYBWcVJrXhciZDIig0
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Вот, что вы увидите перед собой на экране монитора: 

 
 

Все настройки BIOS всегда стоят по умолчанию, поэтому изменять ничего не нужно. Нас 

интересует только одна строка – First Boot Device. Выберите в столбце справа, в этой же 

строке, [CD-ROM].  

Затем выходите из BIOS, нажав клавишу F10. В сплывающем окне система спросит вас, 

действительно ли вы хотите сохранить изменения и выйти из меню. Нажмите клавишу Y. 

Теперь ваш компьютер снова перезагрузится и, согласно нашим изменениям, начнет 

загрузку с компакт-диска.  
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Программа установки Windows XP сама подготовит ваш ПК к инсталляции ОС, но перед 

этим непременно предложит вам прочитать лицензионное соглашение, чтобы 

удостовериться, что вы принимаете все правила использования приобретенного продукта. 

После того, как вы подтвердите это нажатием клавиши на клавиатуре, установочная 

программа скопирует необходимую информацию для загрузки ОС с CD на жесткий диск. 

После копирования вам будет предложено выбрать и отформатировать раздел жесткого 

диска, на который будет установлена ОС, поскольку жесткий диск обязательно должен 

содержать хотя бы один отформатированный раздел. МирСоветов рекомендует 

внимательно следовать подсказкам программы-установки и читать, какие варианты 

действий вам предлагаются. После того, как вы выберете раздел для инсталлирования, 

программа продолжит копирование файлов. По завершению этой операции ваш 

компьютер автоматически перезагрузится.  

Установка Windows XP. Шаг второй. 

После перезагрузки вам будет предложено ввести серийный номер – Serial Number. Он 

должен быть указан на коробке с диском.  

После того, как вы введете «ключ», появится диалоговое окно с выбором установки. Здесь 

тоже все по умолчанию, поэтому нажимаем «Далее» (“Next”). Теперь на экране появится 

окно с параметрами установки. 
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Установите параметры языка. Вам будет предложено выбрать основной и дополнительные 

языки.  

Нажмите кнопку Дополнительные параметры. Откроется окно настроек, в котором будет 

два поля. Первое содержит путь и имя папки с файлами для установки Windows XP 

(значение этого поля должно стоять по умолчанию с компакт-диска). Во втором поле 

указывается папка, в которую будет установлена система (тоже по умолчанию, но если вы 

захотите переименовать папку, сможете это сделать здесь). Специальные возможности на 

установку не влияют, поэтому жмем Далее.  

В следующем окне вы должны будете указать свои персональные данные, - Имя (“Name”) 

и Организация (“Company”). Поле Имя заполняется в обязательном порядке, а вот 

Организацию указывать необязательно, поэтому идем Далее. 

 
 

Следующее диалоговое окно предложит вам выбрать место своего проживания 

(“Location”). От этого зависят форма записи даты, времени, изображение некоторых 

значков (например, значок валюты), а также многие значения, которые в соответствии со 
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страной проживания, устанавливаются по умолчанию (как, например, язык). Помимо 

этого, большинство программ, написанные под Windows XP, подстраиваются под 

параметры, указанные при установке, для более удобной работы. Имейте это в виду! 

Поэтому выбираем из списка страну Россия и нажимаем кнопку Далее. Теперь установка 

Windows XP продолжится в автоматическом режиме и не потребует вашего участия. В 

зависимости от вашего скорости работы вашего ПК установка может занять от 20 до 50 

минут. Причем, в течение этого времени еще несколько раз появится окно, сообщающее о 

необходимой перезагрузке компьютера. Вам не обязательно все это время сидеть перед 

монитором и скучать, вы можете спокойно заняться своими делами, - компьютер сам 

перезагрузится через 15 секунд, а после перезагрузки сам продолжит установку.  

Установка Windows XP. Шаг третий. 

После установки Windows XP и очередной перезагрузки компьютера установочная 

программа произведет автоматическую настройку системы в зависимости от 

особенностей оборудования вашего ПК. Она сама определит его состав и установит 

необходимые драйверы. На протяжении всего этого процесса, на экране будут 

высвечиваться соответствующие диалоговые окошки, сообщающие о действиях 

программы. После завершения этого этапа компьютер снова будет перезагружен (либо 

автоматически через 15 сек, либо после того, как вы нажмете любую клавишу). 

На этом все! Осталось только установить пакет всех необходимых вам программ. А сама 

операционная система Windows XP установлена и готова к использованию. 

 

Подготовка к выполнению работы 

1. Ознакомиться с инструкцией.  

2. Проработать теоретический материал за темой работы. 

3. Дать ответы на контрольные вопросы входного контроля.  

4. Продумать методику выполнения работы. 

5. Подготовить бланк отчета. 

Оборудование: 

ПК и установочный диск с Windows XP   

Оформление отчета: 
1. Цель работы. 

2. Теоретические сведения.  

3. Оборудование. 

4. Задание.  

5. Описание выполненной работы. 

Внеаудиторная самостоятельная работа: 

Ответить на контрольные вопросы письменно в тетради: 

1. Что такое Windows XP? 

2. Перед началом установки что нужно изменить в BIOS? 

Практическая работа №2  

Установка драйверов. 

Цель работы: сформировать умения установки драйверов 

Задание 1. Изучение процесса установки драйверов 

Методические указания по выполнению задания: 

1. Убедитесь в том, что компьютерная система обесточена (при необходимости, 

отключите систему от сети). 

2. Разверните системный блок задней стенкой к себе. 

3. По наличию или отсутствию разъемов USB установите форм-фактор материнской 

платы (при наличии разъемов USB - форм-фактор АТХ, при их отсутствии -AT). 

4. Установите местоположение и снимите характеристики следующих разъемов: 

 питания системного блока; 

 питания монитора; 



13 

 

 сигнального кабеля монитора; 

 клавиатуры; 

 последовательных портов (два разъема); 

 параллельного порта; 

 других разъемов. 

5. Убедитесь в том, что все разъемы, выведенные на заднюю стенку системного блока, не 

взаимозаменяемы, то есть каждое базовое устройство подключается одним 

единственным способом. 

6. Изучите способ подключения мыши.  

Мышь может подключаться к разъему последовательного порта или к специальному 

порту PS/2, имеющему разъем круглой формы. Последний способ является более 

современным и удобным. В этом случае мышь имеет собственный выделенный порт, 

что исключает возможность ее конфликта с другими устройствами, подключаемыми к 

последовательным портам. Последние модели могут подключаться к клавиатуре через 

разъем интерфейса USB. 

7. Заполните таблицу: 

Разъем Тип разъема 
Количество 

контактов 
Примечания 

    

    

 

8.  Определить наличие основных устройств персонального компьютера. 

9. Установите местоположение блока питания, выясните мощность блока питания 

(указана на ярлыке). 

10. Установите местоположение материнской платы. 

11. Установите характер подключения материнской платы к блоку питания.  

Для материнских плат в форм-факторе AT подключение питания выполняется двумя  

разъемами. Обратите внимание на расположение проводников черного цвета - оно 

важно для правильной стыковки разъемов. 

12. Установите местоположение жесткого диска.  

Установите местоположение его разъема питания. Проследите направление шлейфа 

проводников, связывающего жесткий диск с материнской платой. Обратите внимание 

на местоположение проводника, окрашенного в красный цвет (на жестком диске он 

должен быть расположен рядом с разъемом питания). 

13. Установите местоположения дисководов гибких дисков и дисковода CD-ROM.  

Проследите направление их шлейфов проводников и обратите внимание на положение 

проводника, окрашенного в красный цвет, относительно разъема питания. 

14. Установите местоположение платы видеоадаптера.  

Определите тип интерфейса платы видеоадаптера. 

15. При наличии прочих дополнительных устройств выявите их назначение, опишите 

характерные особенности данных устройств (типы разъемов, тип интерфейса и др.). 

 

 

16. Заполните таблицу: 

Устройство Характерные особенности Куда и при помощи чего 

подключается 

   

 

Внеаудиторная самостоятельная работа: 

Ответить на контрольные вопросы письменно в тетради: 

1. Архитектура вычислительных систем. 

2. Состав системного блока. 
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3. Назначение, основные характеристики, интерфейс устройств персонального 

компьютера (по каждому устройству), входящих в состав системного блока. 

4. Устройство жесткого диска 

1. Базовая аппаратная конфигурация; 

2. Основные характеристики  монитора; 

3. Характеристики (тип разъема, количество контактов, скорость передачи данных) 

разъемов: видеоадаптера; последовательных портов; параллельного порта; шины USB; 

сетевой карты; питания системного блока; питания монитора. 

4. Типы периферийных устройств. 

 

Практическая работа №3  

Построение одноранговой сети. Настройка локальной сети. 

Цель: изучить виды и классификацию локальных сетей, физические среды передачи 

данных, научиться устанавливать и настраивать сетевой интерфейс. 

Оборудование: персональный компьютер, сетевая карта. 

Базовые сведения:  

Перед началом настройки сетевого интерфейса необходимо установить и настроить 

сетевую карту. После корректной установки драйвера сетевой карты необходимо 

настроить сетевые протоколы, которые будут использоваться на данном интерфейсе. 

После настройки протоколов проверяется работа системы в сети, начиная с команд ping 

для проверки связности на физическом и канальном уровне, tracert для проверки работы 

маршрутизации, и заканчивая работой конкретных приложений (электронная почта, веб-

сервер) прикладном уровне. 

Порядок выполнения: 

Подготовка к выполнению работы 

1. Изучите настоящие указания, уточните непонятные моменты. 

2. Если монитор вычислительной системы имеет питание, отдельное от системного 

блока, включите монитор. 

3. Включите компьютерную систему выключателем системного блока. 

4. При появлении запроса о пароле нажмите на клавиатуре клавишу Esc.  

Установка протоколов 

5. Нажмите кнопку Пуск на панели задач. Выберете пункт Настройка -> Панель 

Управления. 

6. Нажмите кнопку Добавить… Выберите тип устанавливаемого компонента: Протокол. 

Нажмите кнопку Добавить… 

7. Выберите соответствующие пункты в окнах Изготовители: Microsoft и Сетевые 

протоколы: IPX/SPX-совместимый протокол. Нажмите кнопку OK. 

8. Нажмите кнопку OK. 

9. Для корректной настройки драйвера перезагрузите систему (условно). 

Удаление протоколов 
10. Нажмите кнопку Пуск на панели задач. Выберете пункт Настройка -> Панель 

Управления. 

11. Откройте объект Сеть. В появившемся окне на вкладке Конфигурация выберите 

компонент IPX/SPX-совместимый протокол. Нажмите кнопку Удалить… 

12. Для корректной настройки драйвера перезагрузите систему (условно). 

Настройка сетевого протокола TCP/IP 

13. Выберите компонент TCP/IP. Нажмите кнопку Свойства. В появившемся окне:  

13.1. на вкладке Адрес IP снимите значения параметров IP-адрес и Маска подсети  

13.2. на вкладке Шлюз снимите значения параметра Установленные шлюзы  

13.3. на вкладке Конфигурация снимите значения параметров Имя компьютера, 

Домен, Порядок просмотра серверов DNS.  

13.4. Нажмите кнопку OK. 
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Проверка настройки протокола 

14. После перезагрузки компьютера проверьте работу сетевого интерфейса командой ping 

IP-адрес и работу сервера DNS командой ping доменное_имя. Адреса и доменные 

имена для проверки работы сети (получить у преподавателя): 

IP-адрес Доменное имя Примечание 

   

   

   

Проверьте работу маршрутизации командой tracert IP-адрес (tracert доменное_имя). 

Адреса и доменные имена для проверки работы сети (получить у преподавателя). 

15. Заполните таблицу: 

№ 

п/п 
Наименование Значение 

1.  Сетевая плата  

2.  Используемые протоколы  

3.  IP-адрес  

4.  Маска подсети  

5.  Доменное имя компьютера  

6.  DNS-сервер(ы)  

7.  Шлюз  

 

Завершение работы 

16. Уточните у преподавателя порядок завершения работы с компьютером. Приведите 

компьютер в исходное состояние. 

 

Внеаудиторная самостоятельная работа: 

Ответить на контрольные вопросы письменно в тетради: 

1. Порядок настройки стека протоколов TCP/IP. 

2. Что такое: 

IP-адрес, маска подсети, доменное имя, DNS-сервер, шлюз. 

3. Маршрутизация. Принципы маршрутизации. 

4. Назначение и принцип работы сервиса ARP. 

5. Как определить доступность вычислительной системы по сети? 

 

Практическая работа №4  

Комплектация рабочих мест средствами вычислительной техники. 

Цель работы: сформировать умения комплектации рабочих мест средствами 

вычислительной техники. 

Задание 1. Комплектация рабочих мест средствами вычислительной техники. 

Методические указания по выполнению задания: 

Согласно системным требованиям программы AutoCAD 2016 выполнить комплектацию 

рабочего места средствами вычислительной техники для инженера ПТО.  

Порядок работы: 

1. Выбрать все компоненты для автоматизированного рабочего места в Интернет 

магазине (например, nix.ru). Конечный результат – это корзина с покупками и 

итоговая цена.  

2. Составить презентацию, для каждой позиции из корзины – 1 слайд: название, 

картинка, характеристики устройства, цена. 

3. Подготовить доклад по презентации на 1 минуту. 

Примерная комплектация рабочего места средствами вычислительной техники: 

Персональный компьютер: 

— процессор; 
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— видеокарта; 

— материнская плата 

— оперативная память; 

— жесткий диск; 

— устройства ввода-вывода; 

— накопители информации, и т.д. 

 

При выборе техники: 

— печатающие устройства (принтеры, плоттеры); 

— коммуникационное оборудование (модемы); 

— устройства ввода изображений (сканеры), и т.д. 

…обратить внимание на особенности проектной документации (формат…) 

 

Практическая работа №5  

Устройства для работы с информацией на твердых носителях. 

Цель работы: изучить устройства для работы с информацией на твердых носителях. 

Задание 1. Устройства для работы с информацией на твердых носителях. 

Методические указания по выполнению задания: 

Заполнить таблицу: 

Устройства для работы с 

информацией на твердых 

носителях. 

Объем Стоимость Плюсы Минусы 

…     

…     

…     

 

Практическая работа №6  

Разбиение жесткого диска на разделы различными средствами. Работа с 

программным обеспечением по обслуживанию жёстких магнитных дисков. 

 

Цель работы: сформировать умения разбиения жесткого диска на разделы различными 

средствами, навыки работы с программным обеспечением по обслуживанию жёстких 

магнитных дисков.. 

Задание 1. Разбиение жесткого диска на разделы различными средствами.. 

Методические указания по выполнению задания: 

Вы можете разделить жесткий диск или SSD во всех последних версиях Windows в уже 

установленной системе. Единственное условие — чтобы свободного места на диске было 

не меньше, чем вы хотите выделить под второй логический диск. 

Для этого, проделайте следующие шаги (в этом примере будет разбит системный диск C): 

1. Нажмите клавиши Win+R на клавиатуре и введите diskmgmt.msc в окно 

«Выполнить» (клавиша Win — это та, которая с эмблемой 

Windows).  
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2. После загрузки утилиты управления дисками, кликните правой кнопкой мыши по 

разделу, соответствующему вашему диску C (или другому, который нужно разделить) и 

выберите пункт меню «Сжать 

том». 

 
3. В окне сжатия тома, укажите в поле «Размер сжимаемого пространства» тот 

размер, который вы хотите выделить под новый диск (логический раздел на диске). 

Нажмите кнопку 

«Сжать».  
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4. После этого, справа от вашего диска появится пространство, которое «Не 

распределено». Кликните по нему правой кнопкой мыши и выберите «Создать простой 

том». 

 
5. По умолчанию для нового простого тома указан размер, равный всему незанятому 

пространству. Но вы можете указать меньше, если требуется создать несколько 

логических дисков. 

6. На следующем шаге укажите букву создаваемого диска. 
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7. Задайте файловую систему для нового раздела (лучше оставить все как есть) и 

нажмите 

«Далее».  

После этих действий, ваш диск будет разделен на два, а вновь созданный получит свою 

букву и будет отформатирован в выбранную файловую систему. Можно закрывать 

«Управление дисками» Windows. 

Как разделить диск на разделы в командной строке 

Разбить жесткий диск или SSD на несколько разделов можно не только в «Управление 

дисками», но и с помощью командной строки Windows 10, 8 и Windows 7. 

Будьте внимательны: показанный далее пример сработает без проблем только в тех 

случаях, когда у вас есть единственный системный раздел (и, возможно, пара скрытых), 

который нужно разделить на два раздела — под систему и данные. В некоторых других 

ситуациях (диск MBR и уже есть 4 раздела, при уменьшении диска, «после которого» 

находится еще один диск) это может работать неожиданно, если вы начинающий 

пользователь. 

Следующие шаги показывают, как разделить диск C на две части в командной строке. 

1. Запустите командную строку от имени администратора (как это сделать). Затем по 

порядку введите следующие команды 

2. diskpart 

3. list volume (в результате выполнения этой команды следует обратить внимание на 

номер тома, соответствующего диску C) 

http://remontka.pro/run-command-line-admin/
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4. select volume N (где N — номер из предыдущего 

пункта) 

 
5. shrink desired=размер (где размер — число, заданное в мегабайтах, на которое мы 

сократим диск C, чтобы разбить его на два 

диска). 

 
6. list disk (здесь обратите внимание на номер того физического диска HDD или SSD, 

на котором находится раздел 
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C). 

 
7. select disk M (где M — номер диска из предыдущего пункта). 

8. create partition primary 

9. format fs=ntfs quick 

10. assign letter=желаемая_буква_диска 

11. exit 

Готово, теперь можно закрыть командную строку: в проводнике Windows вы увидите 

вновь созданный диск или, вернее, раздел диска с указанной вами буквой. 

 

Практическая работа №7  

Подключение и инсталляция  принтера. Настройка параметров работы принтеров. 

Замена картриджей. 

Цель работы: сформировать навыки работы подключения и инсталляция принтера, 

настройки параметров работы принтеров, умения замены картриджей.  

Задание 1. Подключение и инсталляция принтера. Настройка параметров работы 

принтеров. Замена картриджей. 

Методические указания по выполнению задания: 

Достаем принтер, кабеля к нему, установочный диск и картридж. Освобождаем принтер от 

упаковочной ленты. Открываем переднюю крышку для установки картриджа (обычно 

располагается или в верхней части принтера, или в нижней). Пришло время вставить 

картридж. Извлекаем картридж из упаковки, снимаем упаковочную бумагу. Не сильно 

встряхиваем его несколько раз, чтобы тонер равномерно распределился. Не беритесь за 

зеленую область картриджа. Чтобы ее не касаться, возьмите картридж за ручку. 
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Теперь находим пазы для картриджа (за передней крышкой) и аккуратно его вставляем до 

щелчка. Закрываем крышку. Проследите, чтобы она плотно прилегала, иначе при печати 

могут возникнуть ошибки. 

Открываем лоток для бумаги и загружаем в нее листы (желательно не более 100-150шт.). 

Следим за тем, чтобы бумага лежала ровно (в противном случае это может привести к 

замятию листов). 

Переходим к непосредственному подключению принтера к компьютеру. Берем кабель 

питания, вставляем его в разъем сзади принтера. Теперь достаем USB кабель для того, 

чтобы подключить устройство к компьютеру. Один край подключаем к системному блоку 

(чуть позже, во время установки драйверов), второй - в принтер (компьютер и принтер 

должны быть выключены!). 

 
Включаем компьютер, ждем полной загрузки. Включаем принтер в сеть, выключатель 

питание ставим в рабочее положение. Вставляем установочный диск с привод и следуем 

подсказкам на экране. После установки драйверов распечатается тестовая страница. Затем 

можно управлять настройками принтера, зайдя в Пуск – Настройки - Принтеры и факсы. 
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Рис.1. Инструмент настройки «Устройства и прентеры» 

На диске с драйверами Вы, скорее всего, найдете программу Adobe Acrobat Reader (в 

новых принтерах может идти Adobe Acrobat 9) с помощью которой можно создавать 

файлы с расширением pdf. Так же можно установить множество сторонних программ и 

утилит, которые будет следить за расходом тонера, предоставлять полный отчет о печати, 

установка ограничений на количество копий и многое другое. Вот некоторые из них: 

InkMonitor (контроль расхода тонера и бумаги), APFill (планирование расхода 

материалов), Printer Usage Cencor (статистика печати), Printing (проверка скорости 

печати). 

Задания: 
1. Подключите принтер и проверьте работоспособность. 

2. Выясните, какой принтер обслуживает ваш компьютер. Результат подтвердите 

скриншотом. 

3. Просмотрите очередь печати вашего принтера. Результат подтвердите скриншотом. 

4. Выполните печать документа с учетом настройки: 

 Распечатайте 1 и 2 страницы лабораторной работы №8 на одном листе. 

 Распечатайте остальные страницы лабораторной работы на листе А5 по 4 

страницы. 

Внеаудиторная самостоятельная работа: 

Ответить на контрольные вопросы письменно в тетради: 

1. Назовите основные характеристики принтеров. 

2. Какие типы интерфейсов существуют для подключения принтеров, использовать сеть 

интернет? 

3. Можно подключить два принтера и более к одному системному блоку? 

4. Какие типы принтеров существуют? 

5. Расскажите принцип работы струйного принтера. 

Практическая работа №8  

Настройка параметров устройств обработки звука. 

Цель работы: приобретение практических навыков в получении и цифровой обработке 

звука c использованием стандартного ПО.  

Задание 1. Настройка параметров устройств обработки звука. 

Методические указания по выполнению задания: 

1 Теоретические основы. Источником представляющих практический интерес 

звуковых колебаний являются микрофон, радио и теле- передачи, ресурсы сети 

InterNet, устройства хранения (CD, магнитная лента, flash) и синтеза звука.  

Звук представляет собой механические колебания физической среды (воздуха, 

скорость распространения около 340 м/сек) частотой приблизительно 20 ÷20000 Гц, 

современные системы обработки звука основаны на преобразовании этих колебаний 

в электрический сигнал, последующей его (аналоговой или цифровой) обработки и 

вывода вновь в виде колебаний физической среды. Эффект стереофонии достигается 

временной разницей колебаний, легко улавливаемой благодаря наличию 

приблизительно 20-сантиметровой базы между приемниками аудиоинформации – 

ушами человека (разница по времени 0,2/340 ≈6×10-4 сек).  

Преобразование аналогового сигнала в цифровую форму выполняет аналого-

цифровой преобразователь (АЦП), служащий для дискретизации сигнала по времени 

(частота оцифровки) и квантования по уровню (собственно цифровое представление 

сигнала). Обычно в АЦП применяется технология преобразования с импульсно-

кодовой модуляцией (PCM, Pulse Code Modulation).  

Временные промежутки между моментами преобразования сигнала называют 

интервалами выборки (Sampling Interval); эта величина обратно пропорциональна 

частоте выборки, или сэмплингом (Sampling Rate). Амплитуда аналогового сигнала 

(Sample Value) при каждом преобразовании делится (квантуется) по уровню и 
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кодируется в соответствующий параллельный цифровой код (Digital Sample), время 

преобразования аналогового сигнала в цифровой код именуется временем выборки 

(Sampling Time), рис. 1. Разрешающая способность АЦП - наименьшее значение 

аналогового сигнала, которое приводит к изменению цифрового кода. Например, 

если АЦП выдает 8-разрядный код, разрешающая способность равна 1/(28)=1/256 от 

максимальной амплитуды аналогового сигнала (около 0,4% в относительных 

единицах), 16-разрядный АЦП имеет точность представления сигнала не хуже 

1/(216)=1/65536 (0,0015%). Увеличение разрядности АЦП приводит к росту его 

динамического диапазона (каждый дополнительный бит соответствует увеличению 

приблизительно на 6 дБ). 8разрядное преобразование обеспечивает динамический 

диапазон 48 дБ (качество кассетного магнитофона), 12-разрядное – 72 дБ 

(качественный катушечный магнитофон), 16-разрядное – 96 дБ (качество аудио 

компактдиска).  

  

  
  

Рисунок 1 — Характеристики процесса преобразования между 

аналоговым и цифровым сигналами/  
  

С практической точки зрения качество аудиовоспроизведения определяется 

скорость передачи данных (bitrate, битрейт). Качество, неотличимое большинством 

рядовых слушателей от качества CD, достигается при скорости передачи 112÷ 128 

Кбайт в секунду; при этом коэффициент MPEG-сжатия достигает 14:1 относительно 

исходного объема. Специалисты обычно требуют скорости передачи 256 ÷ 320 

Кбайт/сек (это легко достижимо для CD-проигрывателя, но для многих 

отечественных InterNet -линий недоступно).  

При цифровой обработке звуковой информации на ЭВМ преобразованию 

подвергается именно цифровое (а не аналоговое) представление сигнала. В  данной 

работе используются формат аудиоинформации WAV (метаформат, при котором 

способ кодирования аудиосигнала может быть любым – напр., PCM без сжатия) и 

сильно компрессированный формат MP3 (MPEG-Audio Layer-3, алгоритм сжатия 

учитывает психоакустическую модель слуха человека).  

При выполнении работы используется программа Nero Wave Editor из 

комплекта Ahead Nero (фирма Ahead Software AG, http://www.nero.com), 

обладающей значительными возможностями по редактированию и преобразованию 

аудиформатов при удобном пользовательском интерфейсе. В цифровом канале легко 
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достигаются многие аудиоэффекты, труднодостижимые при аналоговой обработке; 

напр., реверберация (эффект многократного эха), подавление акустической завязки 

выхода усилителя звуковой частоты на его вход (методом снижения звукового 

уровня в определенном частотном диапазоне) и др.  

Большую часть главного окна интерфейса программы занимает область 

графического представления амплитуды звукового сигнала от времени (амплитудная 

характеристика, АХ), в центре нижней части представлены окна мгновенной 

амплитудно-частотной характеристики (АЧХ) сигнала (для каж-дого стереоканала 

отдельно), рис. 2. Управление программой стандартное –  через главное меню и 

‘горячие’ кнопки в верхней части главного окна. Через вариант главного меню Edit 

доступны функции копирования всего или части (выбор нужного фрагмента 

осуществляется проведением мыши с нажатой левой кнопкой вдоль графика АХ) 

аудиофайла и конвертации его формата, вариант View позволяет управлять формой 

изображения (напр., вместо графика АХ - Wave Display могут быть выбраны 

Spectrogram Display или Wavelet Display). Nero Wave Editor дает возможность 

также осуществлять запись аудиоклипов (Audio →Record).  

  

  
  

Рисунок 2 — Главное окно пользовательского интерфейса программы Nero 

Wave.  
  

Указанный потенциал программы Nero Wave Editor дает возможность гибкого 

редактирования аудиофайлов:  

1. Изменения темпа (скорости) воспроизведения (Tools → Time 

Correction).  

2. Заданного изменения огибающей уровня звука (Volume→ FadeIn, 

Volume FadeOut).  

3. Редактирования АЧХ аудиоклипа (Tools →Equaliser, Transpose, 

Dynamic Processor).  

4. Внесения стандартных эффектов в звучание (Effects → Delay, Flanger, 

Chorus, Reverb).  
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5. Тонкое регулирование качества звука и применение шумоподавления 

(Enhancement  High Frequence Correction, Noise Reduction).  
  

3. Необходимое оборудование – IBM PC-совместимая ЭВМ с 

комплектом аудиоаппаратуры (микрофон, устройства аудио воспроизведения – 

желатель но наличие высококачественных наушников), предустановленные ОС 

Windows и программа Nero Wave Editor.  

  

4. Порядок проведения работы. Студент знакомится с практикой 

получения аудиофайлов различными методами (включая оцифровку записи с линии 

и/или микрофона), производит заданное преподавателем редактирование файлов 

(задаваемое обычно субъективными выражениями) и проверяет (путем 

индивидуального прослушивания через наушники) наличие и качество полученного 

аудиоэффекта.  

  

Типовые задания на редактирование аудиоданных:  

4.1. Изменение воспроизведения темпа аудиоклипа (получение 

‘голоса Буратино’ или ‘утрированного баса’). Провести подобные 

преобразования мето дом Tools → Transpose (использовать настройки 

‘Helium Speech’ и  

‘Monster Speech’).  

4.2. Установка АЧХ аудиоклипа методом использования 

эквалайзера (Tools → Equalizer). При работе учесть, что регулировка 

ширины полосы каждого из 6 каналов эквалайзера осуществляется 

регуляторами Bandwidths (в октавах) в окне Equalizer.  

4.3. Настройка динамических свойств воспроизведения 

(зависимость выходного уровня сигнала от уровня входного, Tools → 

Dynamic Processor). •  

Добавление эффекта однократного эха (Tools → Delay), ‘дрожания’ (Tools →  

Flanger), хорового исполнения (Tools →Chorus), реверберации (Tools → Reverb).  

4.4. Понижение уровня шумов аудиоклипа (Enhancement→ Noise  

Reduction).  
  

5. Оформление отчета по работе. Отчет должно содержать технические 

параметры компонентов аудиосистемы и обработанных аудиофайлов (включая 

частоту семплинга, разрядность оцифровки, используемый битрейт), описание 

произведенных действий по редактированию файлов и полученного эффекта. 

Полученные в результате обработки аудиофайлы предъявляются для 

прослушивания и оценки выполненной работы.  

  

6. Внеаудиторная самостоятельная работа: 

Ответить на контрольные вопросы письменно в тетради: 

 

1. Назвать источники звуковой информации (в порядке личного мнения).  

2. Что представляет собой звук? Каков диапазон частот, воспринимаемых 

человеческим ухом? Какова природа стереоэффекта?  

3. Что такое амплитудная (АЧХ) и амплитудно-частотная характеристики 

(АЧХ), в каких координатах они строятся?  

4. Какие параметры оцифровки звука применяются? Что такое ‘битрейт’ и 

какому качеству звучания соответствуют стандартные величины битрейта?  

5. Что такое эффект реверберации и каким образом он может быть достигнут?  



27 

 

6. Что такое ‘звуковая завязка’ и каковы возможные пути борьбы с ней?  

 

 

Практическая работа №9  

Подключение и инсталляция  сканера. Настройка параметров работы сканера. 

Сканирование документов. 

Цель работы: приобретение практических навыков подключения и инсталляции  сканера, 

настройки параметров работы сканера, сканирования документов..  

 

Задание 1. Подключить сканер и проверить работоспособность используя программное 

обеспечение для распознавания текста.  

Задание 2. Определить характеристики сканера.  

Задание 3. Используя сеть интернет выяснить каким образом подключается планшет и 

световое перо?  

Задание 4. Заполните таблицу Классификация сканеров  

Признак классификации Класс 

Способ формирования 

изображения 

 

 

Конструкция 

кинематического механизма 

  

Тип вводимого изображения   

Степень прозрачности 

оригинала 

  

Аппаратный интерфейс   

Программный интерфейс   

Порядок выполнения работы:  

1. Изучить теоретическую часть.  

2. Выполнить задания практической 

работы. 3. Оформить отчет следующего 

содержания:  

- Тема.  

- Цель.  

- Практическое задание.  

Внеаудиторная самостоятельная работа: 

Ответить на контрольные вопросы письменно в тетради: 

1. Укажите принцип работы сканера?  

2. Для чего используют штрих – код сканер?  

3. Какие достоинства у листопротяжного сканера?  

4. Какой сканер нужно использовать, что бы со сканировать с фотопленки?  

5. Что означает портативный сканер?  

6. Для чего применяются световое перо?  

7. Какие виды планшетов существует?  
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Практическая работа №10  

Настройки и способы сетевых подключений офисной техники. Работа с офисной 

техникой. 

Цель работы: приобретение практических навыков настройки сетевых подключений 

офисной техники, работы с офисной техникой. 

Задание №1 

 Предоставить общий доступ к одному принтеру во всей компьютерной 

локальной сети. 
Ход выполнения 

Для того, чтобы открыть общий доступ к какому-либо принтеру в локальной сети, нужно 

сначала сделать его доступным для всех пользователей. Делается это с помощью таких 

действий: 

- заходим в меню «Пуск – Настройка - Принтеры и Факсы». Откроется окошко, в 

котором высветится список всех принтеров, установленных на текущем компьютере - 

вызываем контекстное меню принтера (нажимаем правой кнопкой мышки на значке с 

принтером) и выбираем из предлагаемого списка меню «Общий доступ». 

 

 
 

- в открывшимся окне нужно перейти на вкладку «Доступ». В ней нажимаем на 

позицию «Общий доступ к этому принтеру» и ниже вводим желаемое имя принтера, 

которое будет отображаться в сети (но лучше оставить имя по умолчанию). Жмем ОК. 

http://edufuture.biz/index.php?title=%D0%A4%D0%B0%D0%B9%D0%BB:Prinr.jpg
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Значок руки возле принтера будет свидетельствовать о том, что все действия проделаны 

правильно и с этого времени принтер будет виден при сканировании сети и доступным 

 

 
 

Задание №2 

 Подключить через сеть к какой-нибудь машине сетевой принтер. 
Ход выполнения 

- заходим в меню «Пуск – Настройка - Принтеры и Факсы». 

http://edufuture.biz/index.php?title=%D0%A4%D0%B0%D0%B9%D0%BB:Dostup.jpg
http://edufuture.biz/index.php?title=%D0%A4%D1%96%D1%88%D0%BA%D0%B8_%D0%B4%D0%BB%D1%8F_%D0%B4%D0%BE%D0%BF%D0%B8%D1%82%D0%BB%D0%B8%D0%B2%D0%B8%D1%85_%D0%B4%D0%BE_%D1%82%D0%B5%D0%BC%D0%B8_%C2%AB%D0%9F%D1%80%D0%B8%D0%BD%D1%82%D0%B5%D1%80._%D0%A2%D0%B8%D0%BF%D0%B8_%D0%BF%D1%80%D0%B8%D0%BD%D1%82%D0%B5%D1%80%D1%96%D0%B2._%D0%A1%D0%BA%D0%B0%D0%BD%D0%B5%D1%80._%D0%9F%D1%80%D0%B8%D1%81%D1%82%D1%80%D0%BE%D1%97_%D0%B4%D0%BB%D1%8F_%D0%BE%D1%80%D0%B3%D0%B0%D0%BD%D1%96%D0%B7%D0%B0%D1%86%D1%96%D1%97_%D0%BA%D0%BE%D0%BC%D0%BF%E2%80%99%D1%8E%D1%82%D0%B5%D1%80%D0%BD%D0%BE%D0%B3%D0%BE_%D0%B7%D0%B2%E2%80%99%D1%8F%D0%B7%D0%BA%D1%83%C2%BB
http://edufuture.biz/index.php?title=%D0%A4%D0%B0%D0%B9%D0%BB:Spilniy.jpg


30 

 

- в левой части окна выбираем пункт «Установка принтера». После чего откроется 

Мастер установки принтера. Нажимаем Далее. 

- в предлагаемом списке выбираем пункт «Сетевой принтер или принтер, 

подключенный к другому компьютеру». Этим мы даем знать машине какой тип 

принтера нужно установить 

 

 
 

- последний шаг в установке сетевого принтера заключается в поиске всех имеющихся в 

сети и выборе нужного нам. Поэтому выбираем «Обзор принтеров» и Далее. 

 

 
 

После окончания поиска Мастер установки выдаст список найденных принтеров. Из него 

выбираем нужный и жмем «Установить». 

Вот и все. Теперь этот компьютер может печатать через принтер, подключенный к другой 

машине. 
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